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The Synthesis and
Analysis of Aspirin

Acetylsalicylic acid is the chemical name for aspirin, the ubiquitous pain reliever. One of the compounds used in the synthesis of aspirin is salicylic acid, which is itself a pain reliever that was known to many ancient cultures, including the Native Americans who extracted it from willow tree bark. Salicylic acid is extremely bitter tasting, and frequent use can cause severe stomach irritation. The search for a milder form of this pain reliever led to the successful synthesis of acetylsalicylic acid by the German chemist Felix Hoffmann in 1893.

Your two primary objectives in this experiment will be to synthesize and analyze aspirin. There is more than one way to synthesize aspirin; in this experiment, you will react acetic anhydride with salicylic acid in the presence of phosphoric acid (which acts as a catalyst). The reaction equation is shown below.
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	 Salicylic acid
	Acetic anhydride
	Acetylsalicylic acid
	Acetic acid


You will conduct two tests of your synthesis to verify that you did indeed make aspirin, and to determine its relative purity. First, you will measure the melting temperature of a sample of your product, using a Melt Station. Second, you will use a UV-VIS Spectrophotometer to test the absorbance of salicylic acid impurity in your aspirin sample.
OBJECTIVES

In this experiment, you will

· Synthesize a sample of acetylsalicylic acid (aspirin).

· Calculate the percent yield of your synthesis.

· Measure the melting temperature of your aspirin sample.

· Conduct a spectrophotometric analysis of your aspirin sample.

MATERIALS

Part I  Synthesis Materials

	50 mL Erlenmeyer flask
	solid salicylic acid

	two 10 mL graduated cylinders
	85% phosphoric acid solution, H3PO4

	25 mL graduated cylinder
	liquid acetic anhydride

	250 mL beaker
	distilled water

	vacuum filtration apparatus
	cold distilled water

	spoon, spatula, or rubber policeman
	balance

	ice bath
	watch glass

	hot plate
	Wide-Range Temperature Probe or 

	plastic Beral pipet or eyedropper
	   thermometer


Part II  Melting Temperature
	LabQuest or computer interface
	aspirin crystals (from Part I)

	LabQuest App or Logger Pro
	tissues (preferably lint-free)

	Vernier Melt Station 
	mortar and pestle (optional)

	glass capillary tubes, one end closed
	


Part III  Spectrophotometric Absorbance
	LabQuest or computer interface
	salicylic acid

	LabQuest App or Logger Pro
	aspirin crystals (from Part I)

	Vernier UV-VIS Spectrophotometer
	ethanol, denatured

	50 mL graduated cylinder
	distilled water

	quartz cuvette with lid
	100 mL volumetric flask

	250 mL beaker
	250 mL volumetric flask

	100 mL beaker
	


PROCEDURE

Part I  Synthesize Aspirin

1.
Obtain and wear goggles. Protect your arms and hands by wearing a long-sleeve lab coat and gloves. Conduct this reaction in a fume hood.
2.
Measure out 2.0 g of salicylic acid into a 50 mL Erlenmeyer flask.

3.
Add 5.0 mL of acetic anhydride and 5 drops of 85% phosphoric acid solution. Swirl the mixture. If necessary, use a sparingly small amount of distilled water to rinse down any bits of solid that may be on the inner walls of the flask. CAUTION: Handle the phosphoric acid and acetic anhydride with care. Both substances can cause painful burns if they come in contact with the skin.

4.
You are now ready to begin the synthesis of aspirin.
a. Prepare a 70–80°C hot-water bath using a 250 mL beaker on a hot plate. Monitor the water temperature.

b. Hold and partially submerge the 50 mL flask and contents in the water bath.

c. Heat the mixture in the hot-water bath for 15 minutes, or until the mixture ceases releasing vapors. Stir the mixture occasionally during heating. Add 2 mL of distilled water about 10 minutes into the heating.
5.
Crystallize the aspirin.
d. When you are confident that the reaction has reached completion (no vapors appearing), carefully remove the flask from the hot plate and add 20 mL of distilled water.

e. Allow the mixture to cool to near room temperature. Transfer the flask to an ice bath for about 5 minutes. As the mixture cools, crystals of aspirin should form in the flask.

6.
Wash the synthesized aspirin.
f. Set up vacuum filtration. Be sure to weigh and record the mass of the filter paper to the nearest 0.001 g before filtering the solid. 

g. Filter the mixture with vacuum suction. 

h. When most of the liquid has been drawn through the funnel, turn off the suction and wash the crystals with 5 mL of cold, distilled water. 

i. After about 15 seconds, turn the suction back on. Wash the crystals with cold, distilled water twice more in this manner.

j. Gently transfer the filter paper with your product onto the watch glass to air dry. As directed by your instructor, either direct a gentle stream of air (low flow) to help dry the solid, or let the solid air dry until the next lab period.

7.
Determine the mass of your dry aspirin sample and record it in the data table.
Part II  Test the Melting Temperature of an Aspirin Sample 

8.
Obtain a small amount of your synthesized aspirin from Part I. The solid should be in a powdered form. If it is not, use a mortar and pestle to carefully grind the solid to a powder. Pack the capillary tube.
9.
Check the control dial on the Melt Station to confirm that it is in the Off position. Connect the Melt Station power supply to a powered electrical outlet.

10.
Connect the Melt Station to a LabQuest or to a computer interface. Choose New from the File menu of the data-collection program.

11.
Carefully insert the capillary tube of solid into one of the sample holders of the Melt Station.

12.
Begin collecting melting temperature data. In the first trial, you will want to observe the melting process and make a rough estimate of the melting temperature of your sample. 


13.
When you have determined the approximate melting temperature range for the sample, stop data collection and turn the dial to the Fan/Cooling setting. Record the melting temperature range in your data table. 

14.
Now that you have a rough idea of the melting temperature, a more accurate determination of the melting temperature can be made. Prepare a sample in a capillary tube and determine the melting temperature of the sample.

15.
When finished, stop data collection and turn the dial to the Fan/Cooling setting. Record the melting temperature range in your data table.


16.
At the end of the experiment turn the control dial on the Melt Station to Off. Dispose of the capillary tubes as directed by your instructor.

17.
Complete the Data Analysis section before exiting Logger Pro or the LabQuest App. Print a copy of your graph and/or save your data, as directed by your instructor.

Part III  Test the Spectrophotometric Absorbance of an Aspirin Sample

Your synthesis converted most, but not all, of the salicylic acid into acetylsalicylic acid. You will spectrophotometrically analyze several samples to determine the amount of salicylic acid impurity in your synthesized aspirin. You can use this information to calculate the purity of your aspirin sample. Follow Steps 18–25 to prepare a set of salicylic acid standard solutions and conduct testing to develop your own Beer’s law plot of the standards. 


18.
Quantitatively prepare 250 mL of a 5.79 × 10-3 mol/L stock salicylic acid solution. Record the mass of salicylic acid to the nearest 0.001 g. Note: Dissolve the salicylic acid in 10 mL of ethanol first, then add distilled water. 

19.
Prepare five standard solutions of varying concentrations of salicylic acid.

k. To prepare 100.0 mL of Solution 1, quantitatively transfer 25.0 mL of the stock salicylic acid solution you prepared in Step 18 to a 100 mL volumetric flask.

l. Prepare the remaining four salicylic acid solutions according to the table below, diluting the sample in the 100 mL flask with distilled water. Mix thoroughly.
m. Calculate the precise molar concentrations of the five solutions in the table below and record them in your data table.

	Solution
	Standard salicylic 
acid solution from 
Step 18 (mL)

	1
	25.0

	2
	20. 0

	3
	15.0

	4
	10.0

	5
	8.0



20.
Disconnect the Melt Station and connect the Vernier UV-VIS Spectrophotometer to the USB port of LabQuest or a computer. 

21.
Connect the AC power supply to the spectrophotometer. Turn the power switch to the ON position. 


22.
When the LED for the lamp indicator stays green, connect the spectrophotometer to the USB port of LabQuest or a computer. Start the data-collection program, and then choose New from the File menu.

21.
Calibrate the Spectrophotometer.

n. To calibrate the spectrophotometer, choose Calibrate ► Spectrometer from the Sensors menu of LabQuest or the Experiment menu of Logger Pro. Note: For best results, allow the spectrophotometer to warm up for a minimum of ten minutes. 

o. Prepare a blank by filling the empty quartz cuvette 3/4 full with distilled water.

p. Place the cuvette into the spectrophotometer. After the spectrophotometer has warmed up, place the cuvette in the spectrophotometer. Align the cuvette so that one of its clear sides is facing the light source.

q. Select Finish Calibration. Select OK. 
r. Remove the cuvette and dispose of the contents. Rinse the cuvette thoroughly.


22.
Determine the optimal wavelength for analysis by collecting a full absorbance spectrum. 
s. Fill the empty quartz cuvette 3/4 full with Solution 1 from the table above.

t. Start data collection. A full spectrum graph of the solution will be displayed. Note that one area of the graph contains a peak absorbance. Stop data collection. 

u. Leave the cuvette in the spectrophotometer. 


23.
Set up the data-collection mode.

Logger Pro (If you are using LabQuest App, see below)
v. Click Configure Spectrometer Data Collection, [image: image2.png]


. Select Absorbance vs. Concentration as the Collection Mode. The wavelength of maximum absorbance (( max) will be selected. 
w. Change the center wavelength value by clicking on the peak absorbance on graph or by choosing the wavelength closest to 275 nm from the list.
x. Select OK. A message will appear warning you to either save or discard the full spectrum run. Make your choice and proceed with data collection. Storing the full spectrum run will show the full spectrum as the top graph with your Beer's Law experiment on the bottom graph. 

y. Proceed to Step 24.
LabQuest App

z. Tap on the peak absorbance around 275 nm; this will automatically be selected when you switch modes. On the Meter screen, tap Mode and change the data-collection mode to Events with Entry.

aa. Enter the Name (e.g., Concentration) and Units (e.g., mol/L). Select OK. A message will appear warning you to either save or discard the full spectrum run. Make your choice and proceed with data collection.
ab. Confirm the wavelength that you wish to measure on the Meter screen. To change the wavelength, tap on the meter itself, and select Change Wavelength. Enter the wavelength of your choice and select OK. If the wavelength you type in is not measured by the UV‑VIS unit, the LabQuest will automatically choose the wavelength closest to your choice.

ac. Proceed to Step 24.

24.
The first solution should still be in the spectrophotometer. Start data collection. After the absorbance reading stabilizes, select Keep. Enter the concentration of the solution and select OK. Collect data for the five solutions. Record the absorbance and concentration values in the data table.

25.
Perform a linear regression analysis. After the preparation and testing of your aspirin sample in the following steps, you will be instructed to interpolate along this plot to determine the concentration of salicylic acid impurity in your aspirin sample.

26.
Prepare the synthesized aspirin sample for testing. Complete this step quickly and be ready to proceed directly to Step 27.

ad. Measure out about 0.2 g of aspirin and transfer it to the 250 mL beaker. Record the mass of aspirin that you use to the nearest 0.001 g.

ae. Add 10 mL of ethanol to the beaker of aspirin sample. Swirl the mixture to dissolve the solid.

af. Add 150 mL of distilled water to the beaker. Mix the solution.

ag. Quantitatively transfer the solution from the beaker to a 250 mL volumetric flask. Thoroughly rinse the beaker with several portions of distilled water, and transfer the rinse water to the volumetric flask. Add distilled water, as needed, to fill the flask to the 250 mL mark. Mix the solution thoroughly.


27.
Measure and record the absorbance value of the treated aspirin sample. This must be done within 10 minutes of completing Step 26. 
ah. Rinse and fill the cuvette 3/4 full with the sample. Cap the cuvette and place it in the Spectrophotometer. 
ai. Monitor the absorbance value on the displayed Meter in Logger Pro (or tap the Meter tab in LabQuest). If the absorbance value falls within the range of the salicylic acid standard solutions, record it in your data table. Note: If the absorbance value does not fall within the range of the salicylic acid standard solutions in your data table, you can repeat Step 26 using a more dilute or more concentrated solution.

28.
To determine the concentration of the salicylic acid impurity in the treated aspirin sample, interpolate along the regression line to convert the absorbance value of the sample to concentration.

aj. Choose Interpolate from the Analyze menu.

ak. Click or tap any point along the regression curve to find the absorbance value that is closest to the absorbance reading you obtained in Step 27. The corresponding salicylic acid concentration, in mol/L, will be displayed to the right of the LabQuest graph, or on your Logger Pro graph.

al. Record the concentration of salicylic acid in your data table.


29.
Discard all solutions as directed.
DATA TABLE

Part I  Synthesis of Aspirin

	Mass of salicylic acid used (g)
	

	Volume of acetic anhydride used (mL)
	

	Mass of acetic anhydride (1.08 g/mL) used (g)
	

	Mass of aspirin and filter paper (g)
	

	Mass of filter paper (g)
	

	Mass of aspirin synthesized (g)
	


Part II  Melting Temperature Data
	Melting temperature range (°C)
	


Part III  Salicylic Acid Standard Stock Solution

	Initial mass of salicylic acid (g)
	

	Initial molarity of salicylic acid (mol/L)
	


Part III  Beer’s Law Data for Salicylic Acid Standard Solutions

	Solution
	Concentration (mol/L)
	Absorbance

	1
	
	

	2
	
	

	3
	
	

	4
	
	

	5
	
	


Part III  Test of the Purity of the Synthesized Aspirin

	Initial mass of aspirin sample (g)
	

	Absorbance of aspirin sample
	

	Concentration of salicylic acid (mol/L)
	

	Moles of salicylic acid in aspirin sample (mol)
	

	Mass of salicylic acid in aspirin sample (g)
	

	Mass of aspirin in sample (g)
	

	Percent aspirin in sample (%)
	


DATA ANALYSIS

1.
What is the theoretical yield of aspirin in your synthesis? The mole ratio is 1:1 between salicylic acid and acetic anhydride in this reaction.

2.
Using a literature source or the internet, find the accepted melting temperature value of pure acetylsalicylic acid. How does the melting temperature test of your aspirin compare to the accepted value?   

3.
Based on the results of the absorbance testing with the Spectrophotometer, what is the percent purity of your sample of aspirin? Does this percent purity compare well with the results of the melting temperature test? Explain.

4.
Use your percent purity calculations to determine the percent yield of your synthesis of aspirin.
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